Version 18.0.5 Enhancements/Corrections

e General:

Added the ability to increase and decrease the text size displayed in a model.

Improved the Automesh feature to detect and create plate corners at existing nodes.

Improved the Move-Rotate tool by rotating all elements when the ‘Apply to Selected’ option is clicked,
despite no elements being selected.

Added a message to alert the user when an invalid value for the shear modulus has been entered for a
Material.

Added the ability to cut a Contour Diagram through the right click menu.

Enabled the option to Pan from the right click menu.

Improved the behavior of templates such that newly created elements will be selected with the Dim
Lock feature enabled.

Resolved an issue where deflections were reported for Inactive members.

Resolved an issue that prevented the generation of members to 'Connect Bays' when copying.

Fixed an issue where design properties edited through the Properties Panel were not properly applied
to the member.

Corrected an issue where Model Merge deleted duplicate nodes which were defined by other elements.
Resolved an issue where incorrect values of Ct were reported in models created in version 17 or earlier.
Resolved an issue where drawing an area load would, in some cases, create a duplicate node.

Resolved an issue where changes in the Application Settings would be applied even when the Cancel
button was selected.

Resolved an issue where the warning log was not cleared after re-solving using Suggested Design.
Resolved an issue causing a Member to rotate about its own local axis when using the Move-Rotate
command about a global axis.

Resolved an issue where incorrect node labels were defined while drawing new plates.

Corrected an issue that enabled the user to edit lateral loads generated by the program.

Corrected an issue allowing duplicate Seismic Design Rule Labels.

Resolved an issue where some generated seismic loads were displayed as zero kips.

Resolved an issue where open structure area loads were not being applied to all members.

Resolved an issue where the span direction was incorrect for area loads defined perpendicular to an
edge.

Resolved an issue with changing the section set material for shapes using internal sizes.

e Interaction:

* Speed:

Added functionality to link models with ArchiCAD.

Improved the speed of opening input and results spreadsheets.

Improved the speed of cancelling while a solution is in progress.

Improved the speed of opening new model files from outside of the program while the program is open.
Improved spreadsheet functionality and speed as the program is used over time.

Improved the speed of the program when animated results are displayed.

Improved the speed of toggling the results display spreadsheets between Load Combinations and
Elements.

Added the E05 wood parameter into the Custom Wood dialog.

Added factored compression resistance into the Combined Bending + Axial section for glulam Detail
Reports per Clause 7.5.12 (CSA 086).

Added the ability to open the Custom Wood Database without needing to define a Custom Wood
Material prior.
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Resolved an issue that prevented SCL materials from being recognized for wood members designed
with CSA 086.

Resolved an issue where lambda was not correctly considered in the wood flexural capacity.

Resolved an issue to correct the governing location for wood members designed with CSA 086.
Resolved an issue where the moment component was not being considered in the Bending and Axial
Compression Analysis for wood members designed with CSA 086.

Corrected an issue where material type was not correctly displayed in the Shape Selection dialog for
wood materials.

Corrected an issue where the incorrect value for unbraced length was used in the calculation for the
slenderness ratio of wood members.

Corrected a display issue where incorrect metric units were shown in the wood Shape Selection dialog.
Resolved an issue where negative bending allowable stress was used for glulam members when positive
bending allowable stress should be used.

Corrected an issue that prevented the Wood Type from saving for newly added Custom Wood Species.

e Wall Panels:

Added the Flip Wall Axis option to the Modify ribbon toolbar.

Enhanced the Flip Wall Axis option to consider openings.

Improved the display of selected wall panel edges when applying loads.

Added a warning message to alert users when attempting to draw on wall panels without first deleting
regions.

Improved Diagram Report to show discontinuity in the force diagram where openings occur.

Fixed an issue where hold downs were not designed for interior boundaries of segmented wood wall
panels.

Resolved issues preventing edits to be made to the Design Rules for openings in wood wall panels.
Resolved an issue preventing point loads from being applied to wall panels.

Resolved an issue that prevented wood wall header results to be shown when using FTAO in Wood
Walls.

e Graphics:

Added the ability to display loads on a deflection animation.

Improved 3D view of locked nodes when instabilities are detected.

Improved the display of plates when showing an animation of deflection.

Enhanced display of Degenerate Plates by activating Dim Lock.

Corrected a display issue with the values on the X-axis in the Contour Diagram Report.

Resolved an issue preventing the color coded unity check to be viewed while animating the deflected
shape.

Resolved an issue preventing the graphical display of member forces while using the Filter Results
command.

Resolved an issue where the display of a Load Combination did not include all applied area loads.
Resolved an issue where the magnitude of animated moving loads were always displayed in units of
kips.

Corrected a display issue where Partial Length line loads were reported as 0-100% in the Property Grid.
Corrected an issue where the Diagram Report displayed a different force diagram than the Wall Panel
Contour Cut.

Resolved a display issue caused by making an animation window full screen.

Corrected a display issue where details in the information box were incorrectly reported when member
deflection ratio labels were displayed in the 3D view.

Resolved an issue where a Contour Diagram for a single wall would display on several walls.
Corrected the graphic display of transient wall panel loads.

Resolved an issue where the Contour Diagram reset the contour basis to Qx.

* Detail Reports:

Added the Unity Check to the top of the Detail Reports.
Added a vertical tracking line that follows the cursor when viewing enlarged force diagrams.
Improved enlarged deflection diagrams by indicating support locations for multispan members.
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* Resolved a graphical display issue with metric units in Masonry Wall Panel detail reports.

* Resolved an issue where column interaction diagrams were erroneously displayed in Detail Reports for
concrete members when no rebar layout was defined.

* Resolved an issue where the Multiple Screen Window Behavior was preventing a previously opened
detail report from staying open.

* Corrected the display of maximum and minimum forces in enlarged force diagrams for members with
custom rebar defined.

* Spreadsheets:

* Added the ability to reset the spreadsheet column widths to Default values.

* Added the ability to sort by relative deflections in the Beam Defl tab of the Member Deflections
spreadsheet.

* Added the ability to use the Fill Cells, Copy, and Paste commands into cells with drop down lists.

* Improved Member spreadsheet by filtering available Design Lists for each material.

* Enabled the Fill Cells command in the Wall Design Rules spreadsheet.

* Improved the Seismic Design Rules spreadsheet by disabling the ability to edit the Overstrength Req’'d
check box for columns.

* Improved the Member Deflections spreadsheet by filtering out material types where deflections aren't
calculated for Service and/or Strength Load Combinations respectively.

* Enabled Math on Block in the Boundary Conditions spreadsheet for boundary conditions defined as
springs.

* Improved results reporting by including an asterisk to indicate which load combinations include
overstrength factors in Envelope spreadsheets.

* Improved the Load Combinations spreadsheet by preventing invalid values from being input in the BLC
column.

* Added error message when trying to create a new line in the Advanced tab of the Wall Panel
spreadsheet.

* Resolved an issue where the order of load combinations was different between the Combination and
Design tab of the Load Combinations spreadsheet.

» Fixed a graphical issue where the header of the Plate Forces spreadsheet did not correlate with the
selected length units.

* Fixed the Copy/Paste command in the Member Advanced Data spreadsheet.

* Resolved an issue preventing a row from being deleted from the General tab in the Materials
spreadsheet.

* Resolved an issue preventing the Math operation from working in the Wall Design Rules spreadsheet.

* Resolved an issue preventing a new row from being added to the Drift Definitions spreadsheet.

* Resolved an issue preventing a valid Section Set from being pasted into another row in the
Section/Shape column of the Members spreadsheet.

* Resolved an issue where the Filter Results selection did not affect the Material Takeoff spreadsheet.

* Resolved an issue preventing the Ignore After option from working in the Code Check spreadsheet.

* Resolved an issue for stainless steel members where Fill Cells command filled the wrong cell in the
Members spreadsheet.

* Resolved an issue that prevented information from being pasted into the Function column of the Time
History Loads spreadsheet.

* Resolved an issue causing information to be pasted in the wrong location in the Time History Loads
spreadsheet.

* Resolved an issue with sorting in the Member Forces spreadsheet.

* Resolved an issue preventing the Fill Cells operation to work for partially fixed advanced members.

* Resolved an issue where members assigned custom supports did not have an asterisk in the Beam Defl
tab of the Member Deflection spreadsheet.

* Resolved an issue where the Property Grid and 3D view did not update when a shape was copy and
pasted in the Section Set spreadsheet.

* Resolved an erroneous error message that appeared after deleting all Time History Loads from the
spreadsheet.
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e Printin

* Operat

g:
Added the option to include the Spectra Scaling Factors report in the Report Printing options.
Enhanced printed spreadsheets by adjusting the column widths.

Added the ability to adjust the text size of spreadsheets when printing a report.

Improved the flexibility of the Print Report Layout to allow for resizing of lists.

Reduced the file size of PDF reports.

Added the ability to include sections from the Advanced tab in Report Templates.

Added the ability to print the Wall Suggested Design spreadsheets for Masonry and Wood wall panels.
Improved printed Model Settings by adding sub-headers for each section.

Added the ability to change view options of individual detail report within a printed report.
Improved Detail Report Options for Wall Panels in Report Printing.

Improved the titles of spreadsheets to better represent the tables being included in a report.
Enabled a larger Report Preview by rearranging items in the Report Print dialog.

Resolved an error in the page numbers when printing reports with non-default page numbering.
Resolved an issue where bottom plate stresses were included in the report when Top Stresses Only
option was checked.

Resolved an issue that prevented all Node Reactions from being displayed in printed reports.
Resolved an issue where only a portion of the spreadsheet would print when the Print Entire
Spreadsheet option was selected.

Resolved an issue preventing the Print Preview to be displayed in its entirety.

Resolved an issue where spreadsheets and graphics were overlapping the report footer.

Resolved an issue with the flat file to report the correct number of lines in the Global Data section.
Resolved an issue where enabling the Member End Point option did not update the reported Member
Section Forces.

Resolved an issue preventing detail reports from fitting to the page in landscape orientation.
Resolved an issue preventing the full expanded detail report for wall panels from being printed.
ions:

Customized Sentinel RMS 9.6 for use with RISA Network Licenses.

Improved messaging when database files are unable to be located.

Improved Log File reporting when an error message occurs on startup.

Resolved several Exception Messages for specific models.

Resolved an issue preventing the ability to scroll through the list of RISASection shapes in the Shape
Database dialog.

Resolved an issue preventing program initialization when certain file locations are changed from the
default in Application Settings.

Resolved an issue preventing warnings from being reported when mesher errors occur.

Corrected a display issue where the windows taskbar hid the program interface when maximized.
Resolved an issue that prevented the program from initializing on first startup.

Resolved an issue that caused the program to close unexpectedly during the animation of Time History
Loads.

Resolved an issue where the program was reporting an 'unable to obtain lock’ error message.
Resolved an issue preventing nodes from being deleted after using the Undo function.

Version 18.0.4 Enhancements/Corrections

e General:

Enabled the Click to Locate option for the DXF Underlay tool.

Enabled the Contour Diagram feature when displaying color contour results for plates and wall panels
in the graphical view.

Enabled the Contour Cut Diagram Report which displays the contour diagram in an expanded view.
Fixed an issue preventing an element from being selected with a single click while using the modify
tools.
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Resolved an issue to correct the left and right height options in the truss generator.

Resolved an issue with Perpendicular Snap Setting creating zero length members.

Resolved an issue where performing a Full Model Merge was not merging all crossing members.
Corrected the Model Merge tool to apply to all members when the whole model is unselected.
Resolved an issue where point loads were always applied at 0’ when using the Apply to Selected option.
Corrected an issue for a specific model where erroneous load was generated using the Wind Load
Generator.

Resolved an issue where the seismic weight reported in the seismic load generator did not match the
sum of the node reactions.

Corrected an erroneous P-Delta warning message after solution.

Resolved an issue when solving with suggested design when the ‘enforce code required P-Delta
analysis’ option is turned off.

Corrected the behavior of Story Drift values in the spreadsheet turning red if they exceed the allowable
amount.

Resolved several Exception Messages for specific models.

Fixed an issue to properly report the version number in the model text file.

Improved spreadsheet functionality and speed as the program is used over time.

Increased the speed of the Round Off Joint Coordinates tool.

Increased the speed for the Degenerate Plate Check tool.

Improved the speed of the rectangular tank generator.

Resolved an issue where deleting large amounts of selected elements took an excessive amount of time.

* Hot-Rolled Steel:

Corrected the display of the slenderness ratio in compression in the Detail Report.

¢ Concrete:

Added the AS/NZS 4671:2001 rebar set.

Added the lintel force diagrams to concrete wall panel Detail Reports.

Added the concrete design values to the expanded diagrams in the Detail Report.

Resolved a graphical issue where the concrete column rebar was not displayed in the Rebar Detailing
diagram.

Corrected an issue for concrete beams using custom shear reinforcement instead of using the design
rule.

Resolved a graphical display issue in the Wall Panel Editor results where concrete reinforcement was
shown using metric bar sizes.

Resolved a graphical issue where concrete lintels were not displayed on the same plane as the wall in
the wall panel editor.

Corrected the Members spreadsheet to specify the system factor, KH, for Canadian codes.

Resolved an issue where the positive and negative bending allowable stresses were switched for glulam
materials.

Resolved a graphical error for wood members using CSA 086-14 where the shear capacity was reported
incorrectly in the Member Detail Report.

Resolved an issue where the wood bending capacities using CSA 086 were reported in the wrong units
in the Member Detail Report.

* Masonry:

Enhanced the masonry wall panel Detail Report to list the total lintel depth in the geometry summary.
Fixed the units for required and available forces reported in the Design Summary of the masonry wall
panel Detail Report.

Corrected the text in the masonry wall Detail Report to display 'Boundary Reinforcement' instead of
'Diagonal Reinforcement'.

Resolved an exception message when opening the Detail Report for a masonry wall panel.

e Wall Panels:

Added an error message to alert users when attempting to draw openings over wall design regions.
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Resolved an issue to allow multiple grid lines to be specified in the Wall Panel Editor.

Resolved an issue to enforce the start and end location logic for distributed loads on wall panels.
Resolved a graphical issue that allowed point loads using percentage to be applied beyond the geometry
of a wall panel.

Resolved an issue where full length distributed loads applied to wall panels retained partial length
information.

Resolved an issue where wall panel reinforcement was not utilizing the Wall Design Rules.

Increased the visibility of the selected plates when using the Wall Panel Internal Force Summation Tool.
Resolved an issue where wall panels would show their deflected shape when the Internal Force
Summation Tool was in use.

* Graphics:

Enhanced the force diagrams displayed graphically by increasing the allowable decimal places for the
magnitudes.

Resolved a graphical issue where column rotation was not displaying correctly for some members.
Corrected a display issue where members were not color coded based on their Section Set.

Corrected the member label graphical display to show the correct unbraced length dimensions.
Resolved an issue with graphically displayed loads where the magnitudes did not reflect duplicate or
seismic factors from the load combination.

Resolved a graphical issue where tapered wall surface loads were incorrectly displayed.

Resolved a graphical issue where projected line loads were displayed using the full magnitude.
Resolved an issue with the graphical display of loads in load combinations with the category set to
None.

Resolved a display issue for transient area loads.

Corrected a display issue where the transient member distributed loads were shown after the results
were cleared.

Corrected the deflected shape button to behave as a toggle to change display options.

Resolved an issue with the Internal Force Summation Tool only displaying results for the first solved
load combination.

* Detail Reports:

e Spread

Added the wall panel label into the Detail Report.

Enhanced the expanded envelope force diagrams to properly report the maximum, minimum values,
and relative load combinations.

Enhanced the detail report enlarged force diagrams to behave as a slider.

Enhanced the effective shear area reported in the expanded detail report calculations to provide clarity
on factors used to account for shear stress distribution.

Corrected the display of the deflection ratio in the Detail Report enlarged deflection diagram.

Updated the deflection ratio reported in the Detail Report for multi-span beams.

Corrected a display issue that caused the detail report axial diagram to be increased by 12.

sheets:

Added a Spreadsheet dropdown menu where you can open spreadsheets and show open spreadsheets.
Added Undo and Redo options into the right-click menu from within spreadsheets.

Added a Save As Default feature to the Load Combinations spreadsheet.

Enhanced the wall panel point and distributed loads to be edited from the Loads spreadsheets.

Added a Re-Solve button to the Suggested Design spreadsheet.

Corrected an issue where the spreadsheet width was not saved.

Resolved an issue preventing the properties from being changed through the Section Sets spreadsheets.
Resolved an issue preventing all section sets from appearing when modifying members through the
Members spreadsheet.

Corrected the ability to copy and paste flexural rebar design parameters in the Members spreadsheet.
Corrected an issue that changed the load type after copy and pasting into Basic Load Cases spreadsheet.
Corrected an error in the Load Combination spreadsheet after deleting spreadsheet lines.

Corrected an issue where the sorted display was not saved in the Node Reactions spreadsheet after the
spreadsheet was closed.
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* Printing:

Added the Model Settings to the Advanced tab in the Report Printing dialog.

Added the ability to Print Selected Lines in spreadsheets.

Enhanced printed spreadsheets by adjusting the column widths.

Enhanced spreadsheet behavior to print as displayed if sorted.

Resolved an issue where the printed Model Setting parameters were not updated correctly.
Corrected the Print Report to keep the Model Settings from changing locations in the report.
Fixed missing column labels when printing the Deflection Design Rules.

Corrected the display of the expanded Wall Detail Report to fit to the full print page.
Corrected the behavior of the print settings: All Member Sections and Member End Points.

e Interaction:

Resolved an issue where certain properties were zeroed out for some hot rolled RISASection shapes.
Corrected an issue during save that caused incorrect file extensions for RISA-2D files imported into
RISA-3D.

* Operations:

Enhanced the Starting a Model dialog to include access to learning tools.

Added options for window behavior to choose between Single Window Focus, Multiple Screen, and
Auto-Docking Windows.

Resolved an issue where a model could not be opened from the File Explorer while an instance of RISA-
3D was in progress.

Corrected an display issue where the edges of the application was cut off when the application was
moved to multiple monitors of different resolutions.

Resolved an issue with online shapes that caused the program to freeze.

Resolved an issue where the warning log was not cleared after opening a new model.

Resolved some issues causing the program to shut down during initialization.

Version 18.0.3 Enhancements/Corrections

e General:

Added the ability to import a DXF drawing grid.

Added the ability to quickly switch your model into 2D Mode.

Enhanced the Copy Global tool with 'Connect Bays' to use W8x10 for connecting members.

Updated the Model Merge tool to detect zero length members and eliminate them.

Updated the behavior when moving wall panels to retain their original openings and boundary
conditions.

Corrected an issue where the ‘Click to Locate’ function for drawing grids was not working as expected.
Resolved an issue where changing the skew angle in the drawing grid caused additional decimal points
to appear in the node coordinates.

Resolved an exception message caused by invalid data in the Saved Drawing Grids.

Resolved an issue where the active tool (ie. Draw Members) would drop after the first click.

Fixed an issue where the Extend tool was incorrectly deleting members.

Resolved an issue where splitting or adding nodes to locked elements was also modifying the unlocked
portion of the model.

Resolved an issue where canceling a modification still produced the Clear Results warning.

Resolved an issue where an incorrect number of duplicate members was being reported in the model
merge.

Resolved an issue that prevented Selection States to be saved with a model.

e Hot-Rolled Steel:

Resolved an issue where the torsional strength for a tube shape was reported with the wrong units in
the Detail Report.

Fixed an issue where the lateral torsional buckling calculation was missing in the hot-rolled angle detail
report.
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Concrete:

* Added the moment interaction diagrams in the Detail Report for concrete rectangular columns.

* Enhanced the metric bar size notation for reinforcement when ASTM A615M rebar is selected.

* Resolved an issue with concrete columns where perimeter bar sizes were reported as CUSTOM despite
having assigned Design Rules.

* Resolved an issue where Custom Rebar Layouts were not saving.

* Resolved an exception message when opening the detail report for a round concrete beam.

* Resolved a graphical display error where concrete column detail reports showed incorrect moment of
inertia values.

* Updated the Concrete Reinforcement spreadsheets to properly display concrete reinforcement detail.

* Updated the Design tab of the Load Combinations spreadsheet to display KD when a CSA 086 wood
design code is selected.
* Updated the wood material default values in the Materials spreadsheet to include SCL materials.
* Resolved an issue that prevented custom wood materials from being created through the Materials
spreadsheet.
* Corrected the displayed solid sawn design values in the Shape Selection database.
* Resolved an issue opening SCL wood databases when switching design codes.
* Corrected the shear design value for glulam members using NDS 18 LRFD.
* Corrected an issue where the wood hold down record counter would become corrupted in some cases.
Masonry:
* Corrected graphical errors in the masonry wall panel Detail Report.
Cold-Formed Steel:
* Fixed an issue for custom ZS shapes where gamma was saved in radians instead of degrees.
* Resolved an issue where cold formed steel properties weren't displaying correctly within the Code
Check spreadsheet.
Stainless Steel:
* Corrected the phi and omega factors when switching between LRFD and ASD design codes.
Graphics:
* General:
* Added the ability to search for inactive members and walls.
* Added the graphical option to customize the scale of nodes.
* Added the ability to graphically display the additional boundary conditions created when using
the All command.
* Added the ability to click white space to clear the current selection.
* Enhanced the graphic display of the Response Spectra input table.
* Resolved an issue where the 3D View was not showing the model.
* Resolved an issue where splitting a member was not retaining the distributed load.
* Resolved an issue where full length distributed loads retained partial length information.
* Wall Panels:
* Enhanced the visibility of wall panels and plates to show in front of the drawing grid.
* Corrected a graphical issue that did not launch the Wall Panel editor after double-clicking the
wall panel.
* Resolved a graphical issue that allowed point loads to be applied beyond the geometry of a wall
panel.
* Increased the visibility of the selected plates when using the Wall Panel Internal Force
Summation Tool.
* Results:
* Added the deflection ratio check to the Design Properties section of the Member Detail Report.
* Added buttons in the Results Explorer panel to view either the Envelope or Batch spreadsheet
results.
* Enhanced the Internal Force Summation tool to report the forces in the information box in the
Properties Panel and consider the selected Results View option in the 3D View.
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* Updated the Member Detail Reports to report the current member label and load combination.
* Resolved an issue where the size adjustment setting was not applied to the Node Reactions.
* Resolved an issue where wall panel deflection would not animate if stress contours were
displayed.
* Fixed an issue where the time steps were not changing when viewing an animated time history
load combination.
e Spreadsheets:
* Added functionality to utilize online shapes in the Section Sets spreadsheet.
* Enhanced the spreadsheet behavior to allow the arrow keys to move the cursor within the text.
* Refined the behavior of spreadsheets when pressing Enter to accept the entry and go to the next row.
* Corrected an issue where pasting into the Nodal Loads spreadsheet would always assign the load type
as displacement (D).
* Corrected an exception message caused by the 'Insert Row Above Selected' option in the load
spreadsheets.
* Fixed an issue where specifying rectangular (RE) shape sizes in the Section Sets spreadsheet caused
error code 1043.
* Resolved an issue where the member size could not be changed after selecting a General section set in
the Members spreadsheet.
* Fixed an issue where the 'Ignore After' and 'Show All' options were not filtering the Code Check results.
* Plates:
* Improved the speed of the plate submesh routine.
* Resolved an issue where incorrect label prefixes were used in the Quad and Tri plate submesh option.
* Resolved an issue where existing plates weren't able to be submeshed using the Auto Submesh option.
* Corrected the Degenerate Plate Check to find non-planar plates.
» Shortcuts:
* Enabled Ctrl+Alt+M to open the Materials spreadsheet.
* Resolved exception messages when using shortcut key combinations.
* Resolved an issue where Ctrl+Alt+] inverted the selection instead of opening the Diaphragms
spreadsheet.
* Fixed an issue where Ctrl+Alt+L locked the unselected part of the model instead of opening the Load
Combinations spreadsheet.
* Solving:
* Resolved an issue where the program was unable to solve an Envelope solution after solving a single
Load Combination.
* Resolved an issue where the warning log was not reporting the location of a meshing error.
* Printing:
* Added the ability to print an individual spreadsheet.
* Added the ability to print directly from the Internal Force Summation Results dialog.
* Added the ability to print the Rebar Detailing section of the Concrete Detail Report.
* Corrected an error where printing reports would cause the program to unexpectedly close.
* Resolved an issue where items added to the report weren't saved after the Report Printing dialog was
closed.
* Resolved an issue where the program wasn't loading previously created Report Templates.
* Interaction:
* Added the ability to Append one model into another model.
* Resolved an issue where certain RISASection files were not allowing the program to open.
* Operations:
* Updated the program to prevent users from accessing a RISA-3D model that is already open by another
user.
* Modified the preview file (.prv) to be a hidden file.
* Corrected an issue to properly save files with the .r3d file extension after importing DXF.
* Resolved an issue that occasionally caused the program to freeze while Clearing Results after
modifications are made with results present.
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* Resolved issues with the backup file where they sometimes could not be opened or re-saved.
* Fixed an issue where the program would automatically minimize after clearing results.
* Licensing:
» Updated the program to enable subscription license users to borrow a license from the cloud service for
offline use.
* Added the ability to run the program in demonstration mode when no license is available.
* Added functionality in new Licensing Dashboard.

Version 18.0.2 Enhancements/Corrections

* General:

* Updated the program to make it easier to change the region as defined in Application Settings.

* Improved functionality of the Fluid Load Generator in the Rectangular Tank Template.

* Resolved a units issue where the Linear Force units were not properly retained in the interface.

» Updated the application of point loads to only apply along the length of the member chosen.

* Resolved an issue where pressing 'Apply to Selected' when elements were locked was also applying
loads to the unlocked portion of the model.

» Enhanced the selection states to differentiate between capital letters for labels that were flagging a
duplicate label warning.

* Resolved an issue where the solution was cleared after adding project grid lines.

* Analysis:

* Improved the speed of solution for plate elements.

* Resolved an issue preventing some models from solving a dynamic analysis with an odd number of
modes.

* Corrected an overly conservative design when using P-Delta with mt/m for Linear Force units.

* Design:

* Resolved an issue with suggested design when the member design list differed from the assigned
member shape type.

* Fixed an issue where solving the model with the suggested design caused an erroneous P-Delta error.

* Hot-Rolled Steel:

» Updated the hot rolled steel compression capacity for wide flange members to consider the flexural-
torsional buckling limit state if Ltorque is greater than either Lby-y or Lbz-z per Section E4 for AISC
15th and 14th Editions.

* Updated the code checks for steel members with slender elements to properly include limit state of FTB
per AISC 14th Section E7.

* Resolved an issue where columns with pinned end releases were reporting panel zone checks.

* Resolved an issue where the web slenderness check for members with minimal frame ductility was
using moderate frame ductility requirements.

* Concrete:

* Updated the warning reported in the Code Check spreadsheet for concrete members which qualify as
deep beams.

* Fixed an issue where certain multi-span concrete beam models were reporting inconsistent required
moments when solved with a single threaded versus multi-threaded solution.

* Resolved an issue that produced erroneous concrete reinforcement warning messages in the warning
log.

* Enhanced the Design List for wood members by setting defaults based on the selected material.

* Resolved an issue that prevented users from entering a size of less than 2” (thick) and/or 3” (depth) for
Full Sawn wood members.

* Corrected an issue where wood shear panel design was incorrectly processing the shear schedule
database.
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* Resolved an issue where certain wood wall panel models with applied point loads would cause the
program to close unexpectedly.
* Enabled the multi-ply and ply connection options for members using SCL or Custom wood materials.
Masonry:
* Resolved an issue where certain models containing masonry wall panels were not opening properly.
* Fixed an issue where certain models were producing inconsistent out of plane masonry capacities when
solved with single threaded versus multi-threaded solution.
Aluminum:
* Resolved an issue preventing custom solid rectangular aluminum shapes from being recognized.
Cold-Formed Steel:
* Resolved an issue where tubes using codes older than 2007 were erroneously reporting a code check.
Cold formed tube shapes only apply to the 2016/2012/2010/2007 codes.
Graphics:
* Graphical View:
* Added the Dim Lock tool which allows the user to Lock a model, but still display the Unlocked
elements as greyed-out elements.
* Resolved a display issue where selected elements were erroneously hidden when using the Lock
tool.
* Corrected a display issue where all node reactions were displayed when using the Lock tool.
* Added the ability to use Undo while deleting members of the model.
* Fixed an issue where models containing only solids were not properly displaying stress contours.
* Ribbon Toolbar:
* Corrected an issue to activate the Detail Report button from the Results tab when in Results
spreadsheets.
* 3D View:
* Improved the graphical scaling of reactions.
* Resolved a display issue that limited the visibility of the reaction magnitudes.
* Properties Panel:
* Enhanced the column widths to automatically size based on contents.
* Resolved an issue where creating a new basic load case would use gravity factors from the
previous basic load case.
* Resolved an issue where re-assigning member end nodes was not capturing the modified
member length.
* Corrected an issue where deflection ratio options were not saved.

* Resolved an issue where assigning an explicit wood shape was not applying the selected
material.
» Selection:
* Improved the selection of loads when using the Select Elements by Properties tool.
* Enhanced the loads tab in the Select Elements by Property dialog by adding a checkbox to take
the absolute value of the loads in the model.
* Resolved an issue that prevented all section sets from appearing in the Select Elements by
Property dialog.
* Dialogs:
* Updated the keyboard Escape behavior to close dialogs, and not windows, when pressed.
* Spreadsheets:
* Added the ability to filter Input spreadsheets based on the graphical selection.
* Improved spreadsheet behavior to prompt a warning if a property is attempted to be deleted
while being assigned to one or more elements.
* Enhanced the sorting hotkey (F9) with more options while in spreadsheets.
» Improved the speed of opening spreadsheets.
* Decreased the time it takes to sort the Code Check spreadsheet.
* Improved the Story Drift Results spreadsheet to switch between the By Combination and By Item
presentation.
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¢ Printin

* Report

e PrintP

* Added the ability to use the Fill Block command in the Boundary Conditions spreadsheet.
* Resolved an issue to allow data to be entered in the Advanced tab of the Boundary Conditions
spreadsheet.
* Corrected issues with copy and paste in some spreadsheets.
* Resolved an issue to show all required decimal places in the Member Torsions spreadsheet.
* Resolved a graphical issue in the Seismic Detailing spreadsheet where certain beams erroneously
reported a failing Miscellaneous Check.
* Resolved a graphical issue where braces with the KL /r requirement unchecked in the seismic
design rule were failing slenderness in the Seismic Detailing spreadsheet.
» Fixed a graphical issue in the Material Takeoff spreadsheet where the incorrect units were
displayed.
» Fixed a display issue that was not reporting the specific governing time step in the results
spreadsheets for a time history solution.
Detail Report:
* Enhanced the wall panel detail report to include units for the reported Required and Available
values in the Detail Report Design Summary.
* Corrected a graphical display issue where the reported moments for the Cb calculation were
erroneously displayed as zero for CSA S16-14.
* Resolved incorrect dimensions shown on the rebar detailing cross section in the Detail Report.
» Fixed a display issue preventing wall panel design results from displaying in the detail report.
* Resolved a display error that did not show the lintel design in masonry wall panel detail reports.
* Resolved an issue caused by clicking to the next member from an expanded detail report
diagram.
g:
Updated the default name of printed PDF files.
Added the ability to Print directly from the Wind, Seismic, and Notional load generators.
Added a custom or summary detail type to the wall panel detail report.
Fixed the ‘Add to Full Report’ option to add member and wall detail reports when the Report Printing
window is open.
Resolved an issue preventing Flat Files from being written for certain models.
Resolved an issue where printing the Envelope Detail Report caused the program to close unexpectedly.
Printing Dialog:
Updated the arrows in the Available Sections For Report to better clarify the collapse/expand
functionality.
Improved printing behavior for the Advanced items in the report printing.
Enhanced the Snapshot feature to display the images under the Advanced section of the Report Printing
dialog.
Refined the presentation of the dragging/reordering sections behavior.
Fixed issues where using the “Select All” option to print detail reports caused the program to hang.
Fixed an issue where the currently selected detail reports were not properly clearing after using the
"Unselect All" option.
Resolved an issue where images could not be re-ordered in the report.
Resolved an issue when specifying different values within the page report numbers.
review:
Resolved an issue where the print preview page size was shown very small.
Resolved an issue where the print preview was not reflecting changes made to the current sections in
the report.

¢ Interaction:

e Operat

Added DXF import and export.

Resolved an issue that prevented some RISASection files from being recognized in RISA-3D.
ions:

Added the ability to access the RISA-3D Help document directly from the File menu.

Added a Save prompt when closing to retain newly created selection states.
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Resolved an issue where a new model could not be opened if the current model was solved.

Resolved an issue where terminating the solution from the solution dialog would cause the program to
lock up.

Fixed the Recall Last Dialog/Tool option from the right-click menu to work for all tools.

Resolved an issue where the program was unexpectedly closing during initialization.

Resolved an issue during installation where some defaults were not properly used based on the selected
region.

Version 18.0.1 Enhancements/Corrections

* Design:

Added additional metric bar sizes for the ASTM A615M rebar set.

Enhanced member design properties to prevent an entry of zero for Cb.

Corrected an issue with the reporting of the lateral torsional buckling factor (Cb) according to AISC.
Refined deep beam criteria according to ACI 318-14 Section 9.9.

Resolved an issue where concrete shear walls were not reporting qualifying seismic piers.
Resolved a display issue for In-Plane Reinforcement of Masonry Shear Walls in Detail Reports.
Corrected an issue with optimizing wall panel hold down selection.

Corrected the wood wall capacity adjustment factor, (2w/h), to apply to both seismic and wind load
combinations per AWC NDS SDPWS 2015 and 2018. Previous codes applied to wind only.

Updated the wood wall calculation of 'Sigma L_i' per AWC NDS SDPWS 2015. This will affect the Shear
Capacity Adjustment Factor, (Co), and the Sheathing Area Ratio, (1).

Resolved an issue where wood design results gave a design check value of infinity (reported as '-
nan(ind)' in the output).

Resolved a units issue for wood wall axial stud spacing results.

Resolved a units issue for metric envelope beam deflections.

Resolved an issue with the user input RSA scaling factor.

Resolved an issue where the solver was not able to mesh certain area loads.

* Integration:

Restored the ability to import a RISA-2D model.

e Graphical View:

Increased the brightness of the selected items in the graphical view.

Improved the scaling of the load display in the 3D View.

Added the ability to select 'Model View Settings' and 'Results View Settings' by right clicking in the
3D model view.

Revised the appearance of distance tool in dark mode.

Corrected a display issue of the results graphically where it did not toggle between Load
Combination/Category/Basic Load Case.

Corrected a display issue for rendered or color coded members with results present.

Corrected an issue that caused the 3D View not to display for some operating systems.

Corrected an issue with the display of animated models.

Resolved an issue where locking the model in certain views would cause it to close unexpectedly.

* Ribbon Toolbar:

Added the ability to use the Undo while drawing or modifying the model.

Enhanced the Results quick view button to display the unity check member label.

Moved the Delete All Wall Regions button next to other Delete features in the Modify tab.
Resolved an exception message that appeared when the Point Moving button was clicked when no
moving load patterns were defined.

Increased the significant digits in the Wall Panel Editor drawing grid to hundredths.

* Properties Panel:

Updated the Point Moving Load feature to the Properties Panel, similar to other drawing tools.
Corrected the Properties Panel to remove rebar parameters for non-concrete members.
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* Corrected the selection of the rebar set for concrete members.
* Refined Property Panel behavior when a nominal wood shape is selected.
* Dialogs:
* Added functionality to the Quick Tips button in some dialog windows.
* Enhanced the Design List by setting defaults based on selected shape.
* Fixed an issue in the Shape Database with shape properties not appearing in the View dialog.
* Improved the Shape Database preview to show the actual sizes of nominal wood members.
* Corrected an issue with deleting a Custom Rebar Layout.
* Corrected the display of the base elevation in the Wind Load Generation to show zero instead of a very
small number.
* Updated the animation settings dialog with a checkbox to stay open.
e Spreadsheets:
» Spreadsheets can be resized and their size is stored throughout the program use and the next session.
e Improved the display of code check results >1.0 to be shown as red and bold.
* Fixed an issue with saving defaults in the Wall Design Rules spreadsheet.
* Resolved an issue preventing data from being pasted in the active Basic Load Case spreadsheet.
* Corrected an issue that caused input loads to be displayed with a multiple of a million due to
international settings using commas instead of periods.
* Added the ability to copy and paste duplicate load combinations.
* Resolved an issue where pasted load combinations would re-sort after closing the spreadsheet.
* Corrected a display issue with the concrete column code check spreadsheet.
* Corrected the reported values in Member End Forces to not be the maximum force for the entire length
of the member.
» Filter Out Unselected Results was corrected to show results for only the selected items.
* Resolved sorting issues for all input and output spreadsheets.
* Corrected an issue so that spreadsheets are minimized when the Report Printing dialog is selected.
* Detail Report:
* Coordinated the shape property geometric variables to match the shape database.
* Resolved an issue where opening a concrete beam detail report would, in some cases, cause the
program to unexpectedly close.
* Revised the detail report for wood members to clarify the direction of the governing shear load.
* Corrected an issue with the display of metric units in detail reports.
» Corrected the display of the location in the expanded diagrams within the Detail Report.
* Resolved spelling errors in the Detail Report of Masonry Walls.
* Corrected an issue where more decimal places were being presented in the wall reinforcement design
than were specified in the application settings.
* Detail Report Printing:
* Fixed an issue with printing enlarged diagrams from a member detail report.
* Corrected print issues for some models when the Add to Full Report checkbox was selected from the
member detail report.
* Report Printing Dialog:
» Fixed an issue with adding spreadsheet results to the report from the Spreadsheets tab.
* Resolved an issue with missing selected detail reports in the Detail Reports tab.
* Fixed an issue with printing wall panel results when choosing ‘Select All’ from the Detail Reports tab.
* Corrected an issue with batch printing of wall panel detail reports for a model without wall panels.
* Restored the ability to print load generation reports (Wind, Seismic, Notional).
* Fixed an issue with the filter selection.
* Corrected an issue where the created report template wasn't automatically being selected after
canceling the creation of a new report template.
* Enhanced the printing of the Detail Report to correct pagination issues.
* Corrected issue with inability to print while Print Report Dialog was not docked.
* Resolved a print issue with a printer on the network.
* Print Preview:
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* Corrected an error from Print Preview scroll pages.
* Corrected the Print Preview display for margins larger than 2 inches.
* Printing:
* Enabled the Print button directly from the dialogs where feature was previously unavailable:
* Member Detail Reports, Wall Detail Reports, Enlarged Diagrams, Time History, Moving Loads,
Response Spectra, Shape Database, Warning Logs
* Added the ability to include Response Spectra plots in reports.
» Aligned the flat file to match the order of the older version and corrected missing sections.
* Enhanced the warning log print with a header.
* Fixed an issue with printing from Edit Moving Load Pattern Definition dialog.
* Corrected the printing of the Detail Report for masonry walls in order to print the expanded sections.
* Resolved an issue that was causing abnormal scaling of printed graphics for Windows 7 machines.
* Operations:
* Added the ability to open a RISA file by dragging the model over the open program.
* Improved the program behavior to copy any missing files automatically for the user upon opening the
program.
* Fixed the Backup file opening mechanism.
* Resolved an issue that caused a corruption of Wood Shear Wall Design Rules upon saving the model.
* Fixed an issue with the program closing unexpectedly after undoing the creation of a wall panel.
* Corrected an issue where applied loads were considered inactive.
* Resolved an issue preventing newly created moving loads from being applied in the model.
* Corrected an error caused by duplicated custom rebar layouts.
* Corrected an issue with losing RISAFoundation information when editing and saving a RISA-3D model
in V18. RISAFoundation integration is not currently supported.
* Installation/Program Opening:
* Resolved an issue that prevented certain models from opening: Index out of Range.
» Corrected an initialization error due to
* Duplicate labels of members, materials, etc.
* Missing Wood Schedule files
* Custom Rebar Layout files
* Inability to write to the Current User registry key
* Corrected the Detail Report display of equations due to missing files in installation.
* Corrected the selection of Load Combinations due to missing files in installation.
* Corrected the installation of Regions (non-US) to a new folder.

Version 18.0 Enhancements/Corrections

e Analysis:
* Added solution multi-threading to utilize multiple CPU cores which drastically reduces envelope and
batch solution times for models with many load combinations.
* Corrected an issue where wind loads were not generated after switching the vertical axis from Y to Z.
* Corrected an issue where Envelope Only solution results were not being retained after closing the
program.
* Corrected an error where area loads applied during dynamic analysis were causing error code 2018.
* Resolved a bug that affected the story height of wall panels when diaphragm elevations were changed.
* Fixed a problem when using metric units where the Member Beam Deflection spreadsheet values were
incorrectly increased by a factor of 25.4.
* Hot-Rolled Steel:
* Revised the leg slenderness classification for double angle detail reports to only consider the longer leg
per CSA S16-14.
* Concrete:
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* Added concrete member deflection diagrams to the detail report.
* Added a warning message for concrete seismic design to better explain the aspect ratio limits.
e Masonry:
» Fixed the cross section detailing image for out-of-plane reinforcement of a masonry wall.
* Cold-Formed Steel:
e Updated the capacities reported in the member detail report to reflect the safety factors for members
analyzed using AISI 1999:ASD.
* Corrected the safety factors used to calculate the allowable capacities reported in the detail report for
members analyzed using cold-formed steel codes 2010 or older.
* Revised the flexural-torsional buckling stress, (Fe), per Section C4.1.2 for doubly symmetric shapes
using AISI S100-07 which was incorrectly using Fe (Eq. C4.1.2-1) which is for singly symmetric sections.
* Resolved a missing input parameter, connector spacing (a), for cold formed steel when a specific
procedure was followed.
» Stainless:
* Resolved a false value of '9.999+' shown for the shear unity check of stainless steel members.
e Aluminum:
* Updated Aluminum Round Tube flexural check to use Section B.5.5.4 in ADM 2015.
* Wood:
* Added LRFD wood design for NDS 2018 and NDS 2015 codes.
* Added the ability to view custom wood material properties through the material selection dialog.
* Updated the wood shape database to reflect the overall thickness based on the number of plies selected.
* Updated the cross-section detailing image for FTAO and Perforated wood walls to be more accurately
represented in detail reports.
* Updated the wood wall calculation of "Sigma L_i" per AWC NDS SDPWS 2015. This will affect the Shear
Capacity Adjustment Factor, (Co), and the Sheathing Area Ratio, (1).
* Corrected the wood wall capacity adjustment factor, (2w/h), to apply to both seismic and wind load
combinations per AWC NDS SDPWS 2015 and 2018. Previous codes applied to wind only.
* Corrected an error in calculating the moment capacity of glulam beams using CSA 086-14.
* Corrected an issue with preserving default custom wood species in the Materials spreadsheet.
* Graphics:
* Detail Report:
* Improved Detail Reports to show expanded calculations for code check.
* Improved output to show all the code references in expanded Detail Reports for all materials.
* Enhanced the member detail report output to report the section modulus and plastic modulus.
* Resolved an issue with missing masonry wall panel labels from the detail report.
* Printing:
* Added batch printing of detail reports.
* Added an interactive Print Preview for the graphical view and reports.
* Added a preview of the custom logo in the print reports.
* Added functionality to edit saved custom report templates.
* Saved page setup properties specified in Printing dialogs as default settings.
* Viewing:
* New graphical user interface with ribbon toolbar.
* Added preview thumbnails for recent projects accessible from the File menu.
* Added custom Snap View options to allow snapping to a view other than the default XY, XZ, YZ,
or ISO.
* Added synchronous display of results based on the load combination selected in the 3D View
drop-down.
* Improved graphic display options in the Quick View toolbar.
* Resolved a graphical issue for members that were copied while displaying color coding.
* Fixed an issue where, in some cases, selected members were not rendered correctly.
* Resolved an issue where lengthy node labels were not properly displayed in the Properties.
* Fixed an issue preventing the display of reactions with an Envelope Only solution.
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» Selection:
* Added the ability to select and edit loads graphically.
* Added a Connection Rule selection filter for members in the Selection Criteria dialog.
* Added all options for tension/compression only members into the Selection Criteria dialog.
* Added the option to Relabel Selected elements in addition to All elements.
* Improved the Select Elements by Property tool to group section sets and shapes together.
* Resolved an issue where Show Selected Lines in Current view was not working properly after
sorting the spreadsheet.
* Spreadsheets:
* Enhanced spreadsheets allow for improved sorting and auto-sizing columns.
* Added all input spreadsheets into the Data Entry drop-down list.
» Improved functionality of selecting/resizing cells in spreadsheets.
» Fixed sorting for all input and output spreadsheets.
* Resolved an issue that prevented the Wall Panel Design spreadsheet from sorting.
* Revised an issue where Select Marked Lines in Current View was not working properly in the
Wall Panel Forces spreadsheet.
* Corrected the text color of failing seismic drift ratios to show red in the Story Drift spreadsheet.
* Resolved a rare occurrence that caused the program to crash when sorting Node Coordinates
spreadsheet.
* Dialogs:
* Added the ability to resize the Wall Panel Editor window.
* Updated the Shape Selection dialog to be more intuitive.
* Resolved a graphics issue to properly show the entire High Level Generation tool dialog.
* General:
* Created a progress bar for calculating seismic loads using the seismic load generation tool.
* Enhanced the High Level Generation tools to draw continuous members.
* Enhanced the creation of solids to extrude from the local axis.
* Enhanced the Extend tool to extend a member to a wall panel or plate.
* Improved the file format of the Help file.
* Modify tools improved to allow rotation and scaling based on a click point.
* Simplified the terms "joint" and "node" to now use node exclusively in all input and output.
» Fixed an issue in the truss generator where truss widths set to out-to-out were incorrectly using
centerline dimensions.
* Corrected an issue where using the extend tool would inadvertently move a boundary condition in some
cases.
* Corrected an issue where scaling a wall panel could lock distributed loads on the panel from being
edited.
* Resolved an issue where adjacent unselected member area loads were deleted during Delete Selected
Area Loads function.
e Corrected an issue where imported time history files would not retain file name upon import.
* Resolved an issue where member function would revert to Lateral after updating member size.
* Corrected an issue where nodes were internally being duplicated after integration for some models.
* Corrected an issue where reactions would graphically disappear after subsequent runs in some cases.
* Resolved a copy and paste issue to only copy RISA-3D column headers when pasting outside of the
program.
* Corrected an issue where material properties were erroneously reporting as N/A in some cases.



